Environmental Response Management Application (ERMA)

Basic User’s Guide

Version 2
May 19, 2016
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>3</td>
</tr>
<tr>
<td>What Is ERMA?</td>
<td>3</td>
</tr>
<tr>
<td>What You’ll Find in This User Guide</td>
<td>3</td>
</tr>
<tr>
<td>ERMA Basics</td>
<td>4</td>
</tr>
<tr>
<td>ERMA’s Origin: A Regional Focus</td>
<td>4</td>
</tr>
<tr>
<td>Making ERMA Go: The Technology that Powers ERMA</td>
<td>4</td>
</tr>
<tr>
<td>Getting Started</td>
<td>6</td>
</tr>
<tr>
<td>Getting an ERMA Account</td>
<td>6</td>
</tr>
<tr>
<td>Recovering Your Password</td>
<td>9</td>
</tr>
<tr>
<td>Recovering Your Username</td>
<td>9</td>
</tr>
<tr>
<td>Logging In and Out</td>
<td>10</td>
</tr>
<tr>
<td>Using the ERMA Window</td>
<td>11</td>
</tr>
<tr>
<td>Map Controls</td>
<td>12</td>
</tr>
<tr>
<td>Map Toolbar</td>
<td>13</td>
</tr>
<tr>
<td>Search Box</td>
<td>14</td>
</tr>
<tr>
<td>Time Slider</td>
<td>16</td>
</tr>
<tr>
<td>Tool Tabs and Table of Contents</td>
<td>17</td>
</tr>
<tr>
<td>Folder/Layer Shortcut Menu</td>
<td>18</td>
</tr>
<tr>
<td>Bookmark Views Control</td>
<td>18</td>
</tr>
<tr>
<td>Display Controls</td>
<td>19</td>
</tr>
<tr>
<td>Map Key</td>
<td>20</td>
</tr>
<tr>
<td>Layers Tab: Working with Bookmark Views</td>
<td>21</td>
</tr>
<tr>
<td>Bookmark Views</td>
<td>21</td>
</tr>
<tr>
<td>Creating and Saving Bookmark Views</td>
<td>22</td>
</tr>
<tr>
<td>Working with Bookmark views</td>
<td>25</td>
</tr>
<tr>
<td>Loading a Bookmark View</td>
<td>25</td>
</tr>
<tr>
<td>Editing an Existing Bookmark View</td>
<td>26</td>
</tr>
<tr>
<td>Deleting an Existing Bookmark View</td>
<td>30</td>
</tr>
<tr>
<td>Using Playlists</td>
<td>30</td>
</tr>
<tr>
<td>Creating a Playlist</td>
<td>31</td>
</tr>
<tr>
<td>Changing the Playlist Running Order</td>
<td>32</td>
</tr>
</tbody>
</table>
Clearing a Slideshow ............................................................................................................................................. 32

Legend Tab................................................................................................................................... 34

Query Tools Tab .......................................................................................................................... 35

Creating and Deleting Polygons...................................................................................................................... 35

Creating a Polygon ................................................................................................................................................ 35

Deleting Polygons.............................................................................................................................................. 36

Using Polygons to View and Analyze Data ...................................................................................................... 37

ERMA Layer Query by Polygon Tool........................................................................................................... 37

NOAA Environmental Sensitivity Index (ESI) Tool.................................................................................... 40

U.S. Fish and Wildlife Service Information, Planning, and Conservation (IPaC) Tool ................... 42

Draw Tab ...................................................................................................................................... 44

Draw Tab Overview................................................................................................................................................ 44

Creating a New Drawing............................................................................................................................. 46

Editing a Drawing........................................................................................................................................... 50

Adding a Drawing to the TOC.......................................................................................................................... 53

Zoom Tab ..................................................................................................................................... 58

Zooming By Latitude and Longitude (Lat/Lon).............................................................................................. 58

Zooming By Place Name (Place).................................................................................................................... 59

Zooming By Ship Number (Ship MMSI) or Ship Name .................................................................................. 59

Download Tab ............................................................................................................................................. 63

Print Tab............................................................................................................................................... 64
INTRODUCTION

What Is ERMA?
The Environmental Response Management Application (ERMA®) is a web-based geographic information system (GIS) tool that helps emergency responders and environmental resource managers deal with incidents that may adversely impact the environment. ERMA combines real-time and static data to display a single interactive map that makes it easy for users to visualize a situation.

Because ERMA is web-based, users do not have to download any proprietary software onto their computers. It also offers the following advantages:

- It facilitates the integration and synthesis of various types of information.
- It provides a common operational picture to all individuals involved in a response.
- It improves communication and coordination among responders and stakeholders.

ERMA gives resource managers the information they need to make informed decisions when dealing with an incident. The maps it generates are worth the proverbial “thousand words” when communicating the status of response activities.

What You'll Find in This User Guide

This guide gives an overview of how ERMA works, and then describes how to use the various parts of ERMA’s user interface. Some of the functions described are available only to ERMA users with accounts or are restricted to users who have certain privilege levels.

The guide contains these sections:

- “ERMA Basics” gives an overview of ERMA, including a brief history of the system’s origins and a discussion of ERMA’s software architecture.
- “Getting Started” tells how to get an ERMA account, how to log in to ERMA, and describes how to use the different parts of the ERMA window.
- “Layers Tab: Working with Bookmark Views” gives an overview of how Bookmark Views work, and provides procedures for creating, saving, loading, editing, and deleting them. It also describes how to create playlists that display Bookmark Views in a specified order.
- “Legend Tab” explains how to interpret the symbols displayed on the ERMA window.
- “Draw Tab” explains how to draw points, lines, and polygons on the map to create drawings that you can share with other ERMA users.
- “Query Tools Tab” describes how to create and edit polygons that you can use to analyze the data available for an area. It also explains how to access data in the NOAA Environmental Sensitivity Index (ESI) maps and in the U.S. Fish and Wildlife Service Information, Planning, and Conservation Tool (IPaC).
- “Zoom Tab” describes the tools you can use to zoom in on specific map locations.
- “Download Tab” explains how to save ERMA data to your computer.
- “Print Tab” describes how to print maps displayed by ERMA.
ERMA BASICS

ERMA is an online mapping tool offering comprehensive access to localized environmental response information. ERMA integrates both static and real-time data, such as Environmental Sensitivity Index (ESI) maps, ship locations, weather, and ocean currents, in a centralized format. It provides environmental responders and decision-makers with access to data for environmental planning, response, assessment, restoration, and incident drills, as well as for other incidents and natural disasters. The system incorporates data into a fast, user-friendly geographic information system (GIS) that can be accessed by command post staff, by active field and remote support teams, and by decision makers and other incident and restoration staff at a variety of locations.

ERMA was developed by the National Oceanic and Atmospheric Administration (NOAA) and the University of New Hampshire with the Environmental Protection Agency, U.S. Coast Guard, and the Department of the Interior in a cross-agency effort.

ERMA’s Origin: A Regional Focus

ERMA projects are focused on specific regions. Currently, ERMA projects exist or are in development for the Gulf of Mexico, the Atlantic, New England, the Pacific Islands, the Pacific Northwest, the Southwest, the Arctic, the Caribbean, and the Great Lakes.

The ERMA pilot was developed for Portsmouth Harbor, New Hampshire. This area was chosen for its proximity to the University of New Hampshire and because of its diverse shoreline development, which includes industrial and residential areas, protected habitats, and tourist/recreational use. Another important reason for selecting Portsmouth Harbor was the active partnership between response agencies, industry, and nongovernmental organizations in New Hampshire and Maine. As a result of these partnerships, existing spatial information (including environmental datasets, habitat classifications and species distributions, navigational charts, high resolution bathymetry, meteorological observations, and trajectory and forecast models) was leveraged to create a response-driven, web-based GIS data management and analysis tool—ERMA. The pilot was tested during area response drills, where it proved effective at providing data transparency while maintaining ease of operation by multiple users.

Making ERMA Go: The Technology that Powers ERMA

ERMA is an integrated data management system that incorporates static base layers along with real-time streams of data (such as weather, tides, and ship tracking data) into a fast, user-friendly Geographic Information System (GIS) that is accessible to the command post as well as people in the field and other locations. ERMA enables a user to quickly and securely upload, manipulate, export, and display spatially referenced datasets, producing a high-impact and fine-resolution visualization of integrated data that can be used to solve complex environmental response and resource issues.

ERMA is designed to store, query, and display spatially referenced data for solving complex questions. The application is based on open source software (PostgreSQL/PostGIS, MapServer, and
OpenLayers, which ensures compatibility with other commercial and open source GIS applications. By overlaying diverse spatial datasets, the user can see the full spectrum of an incident including potential interactions (oil trajectory and resources at risk, for example). ERMA operates in the Federal Information Security Management Act (FISMA) Amazon Cloud, which allows the application to scale as needed for big and small events. The illustration below shows ERMA’s basic software architecture and data flows.
GETTING STARTED

Getting an ERMA Account

ERMA can be used by all to view publically-accessible data. To access non-public data, ERMA users are required to have an ERMA account.

To get a new ERMA account:

1. On the ERMA home page, click the **Login** command in the upper-right corner of the screen.

2. When the Login window appears, click **Request Account**. A new browser window opens.

3. Enter the requested information. While the information you need to provide for many of the fields are self-explanatory, you'll find more details about some of fields below the illustration.

   **IMPORTANT:** You must provide information for all fields that are marked 'Required.'
**Email Address:** Enter a work email address that includes a domain name (the part that comes after the @ symbol. Personal email accounts (such as a Google Mail or Hotmail account) are not acceptable.

**Affiliation:** Open the drop-down list and select the type of organization that you are affiliated with. If none of the listed categories fit your organization, select *Other.*

**Agency Represented:** Enter the name of your organization.

**Contractor:** If you work for your organization on a contract basis, select *Yes.* Otherwise, select *No.*

**Company:** If you are a contractor, enter the name of the contracting company that you work for.

**NOAA OR&R Sponsor:** Enter the name of the NOAA Office of Response & Restoration representative who suggested that you use ERMA.

**Incident Command Post:** If you are part of an active response, enter the name of your incident command post.

**Office Location:** Enter the location of your incident command post or, if you are not part of an active response, the home city of your organization.

**Notes:** Enter any additional information that would be pertinent to the creation of your NOAA account.
4. Click **Submit**. Once your request has been processed, you will receive an automated email message containing your ERMA user name and instructions on how to set your password. The message normally arrives within one business day.

Requests for ERMA accounts are processed by the account management team during regular business hours (Monday through Friday from 8 A.M. to 5 P.M. PT). Processing will be more frequent during a drill or incident. Once your account has been processed you will receive an email from the account management team about accessing ERMA, how to find basic information, names of the regional leads, and basic documentation.

---

**Setting Up Passwords and Account Maintenance**

Your password and user account is an important part of keeping ERMA secure. There are NOAA security guidelines to follow for password creation and user account management, including the following password requirements:

- Every 90 days, your password will expire. When you login, you will be prompted with a message notifying you to reset your password. You may change or reset your password before then by clicking the “Change Password” function at the top right of the page.
- If you have not logged into ERMA for 6 months, your account will expire. Before this happens you will receive an automated email 2 weeks in advance notifying you of this occurrence and to log in again. You will also be required to create a new password.
- If you have not logged into ERMA longer than 6 months and your account is expired, when you try to log in a notice will appear to contact the [orr.ermaaccounts@noaa.gov](mailto:orr.ermaaccounts@noaa.gov) email. Your account will be reviewed and reactivated based on information provided.
Recovering Your Password

To recover your password if you forget or lose it:

1. On the ERMA home page, click the Login command (located in the upper-right corner of the screen).

2. When the Login window appears, click Recover Username/Password.

![Login window with Recover Username/Password highlighted]

3. When the Password Recovery window appears, type your email address (the same address you used when you initially requested your account) in the field provided.

![Password Recovery window]

4. Click Submit. An automated email will be sent instructing you to create a new password.

Recovering Your Username

To recover your username if you forget or lose it:

1. On the ERMA home page, click the Login command (located in the upper-right corner of the screen).

2. When the Login window appears, click Recover Username/Password.

![Login window with Recover Username/Password highlighted]

3. When the Username/Password Recovery window appears, type your email address (the same address you used when you initially requested your account) in the field provided.

![Username/Password Recovery window]
4. Click **Submit**. An automated email will be sent containing your username information.

**Logging In and Out**

**To log in to ERMA:**

1. On the ERMA home page, click **Login** in the upper-right corner of the screen.

2. When the Login window appears, enter your username and password.

3. Read the terms of use detailed in the scrolling box, and once you have checked the box "I Agree", Click **OK**. A message will tell you that your login was successful.

4. Once you are in ERMA you will see a Table of Contents to your right containing data layers and additional tools and tabs made available to those who hold ERMA accounts. Users who have access to multiple Regional ERMA sites can go to them without logging in again.

**To log out of ERMA:**

Click **Logout** in the upper-right corner of the ERMA window. All restricted folders and layers disappear, and a message tells you that the logout was successful.

**NOTE:** If your ERMA window has been inactive for 12 hours, you will be automatically logged out.
USING THE ERMA WINDOW

ERMA data is accessed and displayed using the ERMA window. The elements of this window are shown in the illustration below.
The rest of this section describes these elements, starting with the Map Controls and working around the window clockwise. The exceptions are the Navigation Tabs (explained in separate sections below) and the Login/Logout button (described in the previous section).

The upper-left corner of the ERMA window contains several tabs. The particular ones that you see depend on your privileges. (The Information tab, Help tab, and Recent Data tab are always available.)

- The Information tab opens a window containing general and design information about ERMA.
- The Help tab opens a window containing basic information about using ERMA, including the use of the Map Toolbar and Navigation tabs.
- The Recent Data tab opens a window containing links to data that’s been uploaded recently. Only the layers that you have the needed privileges to view will be visible.
  
  Note: The number of links available and the age of data considered “recent” depend on which ERMA site you are using.
- The Admin tab opens a menu of administrative commands. You’ll see this tab only if you are an administrative user with the appropriate privileges. Admin options may vary based on user privileges.
- The Upload tab opens a window that allows you to upload new shapefiles to ERMA (if you are a Data Uploader with the necessary privileges). For more information on this process, see “Uploading a Shapefile Layer” on page 21.
- The Incident tab opens up in place of the TOC to instruct users how to create a New Incident.

**Map Controls**

The Map Controls are located in the upper-left corner of the map. It contains the following controls.

<table>
<thead>
<tr>
<th>Navigation Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allows you to move the entire map north, south, east, or west.</td>
</tr>
<tr>
<td>To move the map, click the compass point for the desired direction (north, south, east, or west). Keep clicking until the map is where you want it. You can see the latitude and longitude of the new map center in the Map Key at the bottom of the ERMA window.</td>
</tr>
</tbody>
</table>
**Zoom Level Control**

Allows you to zoom in and out of the map to increase or decrease the zoom level, showing more or less detail.

To zoom, click the plus or minus sign on the Zoom Level Control until you’ve reached the desired zoom level. You can see the new zoom level and map scale in the Map Key at the bottom of the ERMA window.

---

**Map Toolbar**

The Map Toolbar is located just to the right of the Map Controls. It contains the following controls and tools.

**Pan Tool**

Allows you to reposition the map by clicking on a spot and dragging the map.

To reposition, select the **Pan Tool** icon and then click a spot on the map. Hold down your mouse button and drag the map until you have the view that you want. (This tool is selected by default.)

**Magnifier Tool**

Allows you to re-center the map on any desired point and then zoom in on that spot.

- To re-center, click the **Magnifier Tool** icon and then click anywhere on the map. Each successive click zooms in on the map’s new center.
- To zoom in on a specific area, click the **Magnifier Tool** icon and then use your mouse pointer to draw a box around the area of interest. When you release the mouse button, ERMA zooms the map in on the area you selected.

You can see the zoom level, map scale, and the latitude and longitude of the map’s new center in the Map Key at the bottom of the ERMA window.

**Previous Extent**

Allows you to zoom the map to the previous extent.

Click the icon to switch to the previous map extent without changing any of the currently selected layers. If the icon is gray, there is no map extent saved.

**Next Extent**

Allows you to zoom the map to the next extent.

Click the icon to restore the next map extent without changing any of the currently selected layers. If the icon is gray, there is no map extent saved.
**Measurement Line**
Allows you to draw a line on the map to measure distances.
To draw a line, click the **Measurement Line** icon and then click the point on the map where you want the line to start. If you single-click at another point, you can continue the line in another direction. Double-click when you want to end the line. You can see a running total of the line’s length in the Map Key at the bottom of the ERMA window. (If you click on the number, you can cycle through various units of measure.)

**Measurement Polygon**
Allows you to draw a polygon on the map to measure areas.
To draw a polygon, click the **Measurement Polygon** icon and then click a point on the map. Move the mouse pointer until you reach the first vertex of the polygon and click again. You can now move the pointer in another direction to create the next side of the polygon. Repeat this process until you’ve enclosed the desired area, and then double-click on the final vertex to complete the polygon. You can see the area enclosed by the polygon in the Map Key at the bottom of the ERMA window. (If you click on the number, you can cycle through various units of measure.)

**Identify Tool**
Allows you to select a point on the map and see attribute information for the layers that are turned on at that particular location.
To see the attribute information, turn on one or more layers. Click the **Identify Tool** icon and then click the desired point on the map. Attribute information will appear in a pop-up window.

**Search Box**
The Search Box is located at the top-center of the ERMA window.

This tool is useful when you want to search for layers, folders, bookmarks, or geographic locations of interest without having to look through multiple folders. Instead, you can enter a word or phrase (which must contain at least three characters) into the Search Box and generate a list of results consisting all of the layers, folders, or bookmarks that have your search term in their names. If you would like to search by locational geography or latitude/longitude, check the “Geographic Search” box and type in the location in the search box. A drop-down list of locations will be displayed.

**To use the Search Box to find information in ERMA:**
1. Type the word or phrase that you are interested in. A list of relevant folders, layers, and bookmarks appears in a drop-down list.
2. You can now select items starting with any of the following:

- **Activate layer**: When selected, the layer is activated, and the data it contains is available for analysis on the map.
- **Show Bookmark**: When selected, a pre-selected group of layers (called a Bookmark View) is displayed on the map.
- **Expand folder**: When selected, the folder is expanded on the Table of Contents, which allows you to look through the folder for other layers that may be helpful.
# Time Slider

The Time Slider player appears at the bottom-right, next to the TOC when time is turned on for a layer.

- Date / Time displayed above the player is what is currently displayed
  - If you hover mouse over it, you see what timezone its in and in UTC
- Date / Time at the bottom of the player is what the start and end of the data currently displayed

This tool is useful when you want to see data over a time span.

---

**To use the Time Slider in ERMA:**

1. In your layer TOC, you should see a clock icon ( ) next to certain layer(s).
2. To activate the Time Slider player, turn on the layer, and then click on the clock icon.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ◀◀     | Previous Time Step  
Allows you to go through the previous time steps |
| ▶▶     | Next Time Step  
Allows you to go through the next time steps |
| ◀▶     | Stop or Loop  
Allows you to stop the time slider at the end or you can continue to the play the time slider from the beginning to the end |
| ?       | Time Slider Help  
Help text that further explains the time slider settings options |

Or

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ◀◀     | Previous Time Step  
Allows you to play the time slider or pause at a desired time. |
| ▶▶     | Next Time Step  
Allows you to go through the next time steps |
| ◀▶     | Stop or Loop  
Allows you to stop the time slider at the end or you can continue to the play the time slider from the beginning to the end |
| ?       | Time Slider Help  
Help text that further explains the time slider settings options |
Tool Tabs and Table of Contents

The Tool Tabs and Table of Contents (TOC) sit on the right side of the ERMA window. The TOC is accessible via the “Layers” Tab. The rest of the tabs in this part of the ERMA window display panels for tools that let you create, manage, and analyze ERMA data. Access to these tools is controlled by the Tool Tabs, which are located at the top of the TOC, just below and to the right of the Find Box and below the Login/Logout button.

These tools are available on the Table of Contents:

- **Layers** tab.
  Allows you to view, create, and manage the layers of information that can be displayed on the map. This tab also allows you to create Bookmark Views and (if you have the needed permissions) share Bookmark Views with other users. For more information, see “Layers Tab: Creating, Editing, and Deleting Layers” on page Error! Bookmark not defined.

- **Legend** tab.
  Helps you interpret the symbology used in the layers displayed on the map. Legend information is automatically generated or updated each time new or different layers are selected for display. For more information, see “Legend Tab” on page 34.

- **Query Tools** tab.
  Allows you to create and edit polygons on the map and then analyze the data available for that area. It also allows you to access data in the NOAA Environmental Sensitivity Index (ESI) maps and in the U.S. Fish and Wildlife Service Information Planning and Conservation Tool (IPAC). For more information, see “Query Tools Tab” on page 35.

- **Draw** tab. (Available only to users with the required privileges.)
  Allows you to draw points, lines, and polygons on the map to create a drawing that you can share with other ERMA users. For more information, see “Draw Tab” on page Error! Bookmark not defined..

- **Zoom** tab.
  Allows you to zoom in on a particular location by latitude and longitude; by the place name; by ship identification number or ship name. For more information, see “Zoom Tab” on page 58.

- **Download** tab.
  Allows you to download certain types of ERMA shapefile information to your computer. For more information, see “Download Tab” on page 63.
• **Print** tab.

  Allows you to print a copy of the map displayed in the ERMA window. For more information, see “Print Tab” on page 64.

**Folder/Layer Shortcut Menu**

This shortcut menu appears when you right-click on the name of a selected layer or folder. It allows you to perform specific operations on that layer or folder, such as zooming to the layer’s extent, viewing the attribute table data, or displaying metadata. The active commands on this menu vary from layer to layer and folder to folder.

**View Attribute Table Data**

Right click on a layer to open the shortcut menu, then click on **View Data** to open its attribute table.

**Bookmark Views Control**

The Bookmark Views control is at the bottom of the **Layers** tab on the Table of Contents. Use this control to open the Bookmark Views panel and create a new Bookmark View.
| **New** | Opens the Save a View panel, which allows you to create a new Bookmark View (including the selection of the Base Views and folders/layers that the new view will include). |
| **Expand/Hide** | Opens and closes the Bookmark Views panel. |

**Display Controls**

The Display Controls are two buttons located in lower-right corner of the ERMA window.

| **Clean** | Allows you to make most of the controls, tabs, and buttons on the ERMA map invisible. (Only the Map Key and the tab you are currently using stay visible.) This is especially useful when taking screen shots or preparing a map for a presentation. To restore the hidden elements, click anywhere on the ERMA window. |
| **Hide/Display TOC** | Toggles the display of the Navigation tabs and Table of Contents (TOC) and expands the map to fill the full ERMA window. |
Map Key

The Map Key is located in the lower-left portion of the map in the ERMA window.

The Map Key has the following elements:

- **A graphic scale** showing how many feet/miles or meters/kilometers are represented by a set length on the map.
- **A north arrow** pointing to the map’s northerly direction.
- **Scale**: A fractional scale showing the ratio between a set length on the map and the real-world distance that this length represents. In the illustration above, one unit on the map represents 2 million units in the real world.
- **Zoom Level**: The zoom level for the current map display, as set on the Zoom Level control. Levels range from 0 (zoomed out to show the full map) to 19 (zoomed in as far as possible).
- **Location**: The location indicated by the mouse pointer, to an accuracy of 1/100000 of a degree.
- **Measurement**: After using the measurement tool to draw a polygon or line, the measurement units will be seen at the bottom of the window in blue font. Click on the measurement number to cycle through different units of measure (such as: metric, standard, and nautical).

Except for the north arrow, all of these elements update automatically to reflect changes in the zoom level or movement of the mouse pointer.
LAYERS TAB: WORKING WITH BOOKMARK VIEWS

ERMA's Bookmark View function allows you to create and save views that provide you with real-time updating for a specific event or a particular interest. By creating Bookmark Views, you avoid having to assemble new sets of layers each time you want a particular view of ERMA's data. If you have the needed access permissions, you can also share your views with other users.

You can also subscribe to Base Views. Base Views are bookmarks, created by others, that are typically relevant to a high-priority incident or area, such as pertinent operations information gathered during an incident response.

This section gives an overview of ERMA's Bookmark Views, including instructions on how to create and save a Bookmark View and on how to use Bookmark Views to create your personal ERMA default view. It also tells how to set up a playlist that displays Bookmark Views automatically in a specified sequence.

Bookmark Views

Click the Expand button on the Bookmark Views control at the bottom of the tab (below left), to open the Bookmark Views panel. Any Bookmark View that you create is shown under My Views at the top of the list (below right), while the rest of the panel displays a list of shared views.

To close the Bookmark Views panel, click the Hide button on the Bookmark Views control.
Creating and Saving Bookmark Views

This "on-the-fly" method can be useful when you realize that the current map view is one that you’d like to be able to use again later.
To create and save a new Bookmark View from the current map view:

1. On the Layers tab, click the **Expand** button on the **Bookmark Views** control at the bottom of the tab.

2. When the Bookmark Views panel appears, click the **New** button and the **Save a View** panel opens.

**Hint:** If you right-click on a folder's name before you click **New**, the folder name will be automatically populated in the **Name** field on the **Save a View** panel. For example, if you right-click on Environmental Unit and then click **Save Current View**, the text Environmental Unit > appears in the **Name** field.
3. If there is no name in the **Name** field already, enter a name for the new Bookmark View. This name should be descriptive and should help you (and other users, if you share the view) know what the Bookmark View shows on the map.

   By default, the new Bookmark View will be put into the root level of the list. If you want the view to go into a folder, use a > character to indicate each folder level. For example:

   **Some Spill > 2012 Views > Fish**

   *IMPORTANT: Make sure to put a space after the > character.*

4. In the **Description** field, enter a more detailed description of the Bookmark View. It's a good idea to list the layers and views included in the new Bookmark View, and to give other users an idea of why you think these layers and views should be seen together.

5. If you want the new Bookmark View to be loaded automatically when you log in to ERMA, select the **Set as my default view** check box.

6. If you want to share the new Bookmark View with other users, select the **Share** check box. All users who have the appropriate permissions will be able to use your Bookmark View.

   *NOTE: It not possible to save a bookmark in My Views and Shared Views at the same time. To save the bookmark in both places, you must save the book mark in both places.*

7. Click the **Save** button at the bottom of the panel.
Working with Bookmark views

This section gives procedures for loading, editing, and deleting Bookmark Views.

Loading a Bookmark View

To load a Bookmark View:

1. On the Layers tab, click the Expand button on the Bookmark Views control at the bottom of the tab.

2. After the Bookmark Views panel opens, click on the name of the Bookmark View that you want to load. The map will update to show the data in that view.
Editing an Existing Bookmark View

NOTE: If the bookmark is not shared out, only the owner can edit it. If the bookmark is shared, only the owner and other users with the privileges to share bookmarks can edit it.

To edit a Bookmark View:

1. On the Layers tab, click the Expand button on the Bookmark Views control at the bottom of the tab.

2. After the Bookmark Views panel opens, click on the bookmark you’d like to edit. Then, on the Active View panel, located just above the Bookmark Views panel, click on the Edit button.
Hint: For a shortcut, right-click on the name of the Bookmark View that you want to edit. A pop-up menu appears. On the menu, click Edit View. The Save a View panel appears, displaying the current information for that Bookmark View.

3. Whichever method you use, clicking the Edit button or clicking Edit View, the next thing you should see is the Save a View panel. In the Name field of the Save a View panel, make any needed changes to the name of the Bookmark View. As with the original name, your new name should be descriptive, and help you (and other users, if you share the view) know what the Bookmark View shows on the map.

If you want the Bookmark View to go into a folder, use a > character to indicate each folder level. For example:

**Some Spill > 2012 Views > Fish**

**IMPORTANT:** Make sure to put a space after the > character.
4. In the **Description** field you can edit or add a description of the Bookmark View. It’s a good idea to list the layers and views included in the Bookmark View and to give other users an idea of why you think these layers and views should be seen together.

5. If you want the Bookmark View to be loaded automatically when you log in to ERMA, select the **Set as my default view** check box. If you do not want it to be the default, make sure the check box is cleared.

   *Note: Only Bookmark Views in your **My Views** list can be edited to be your default view. If you want to make a **Shared View** your default view, save the **Shared View** as a new **My View**.*

6. If you want other users to be able to use the new Bookmark View, select the **Shared** check box.

   **IMPORTANT:** Only users who have the appropriate permissions can share Bookmark Views.

7. Click the **Subscribe to Base Views** control. The Subscribe to Base Views panel opens.

   Subscribing to Base Views allows you to rely on bookmarks created by others which you won’t need to maintain or update and can include in your own views. This is useful for a bookmark such as Response Operations created by another user where you’d want to constantly see all the current boom, vessels, or teams without updating it yourself. You could subscribe to this bookmark and build on it with your own shoreline data to keep tabs of how the shoreline might be impacted by operations or how it should be protected. Another example to subscribe to would be a bookmark of oceanographic data such as currents, tides, and wave heights.
8. Highlight each Base View that you want to edit your Bookmark View to include. These can include your own saved views or Bookmark views saved and shared by other users. 

**NOTE:** If you choose to include Base Views, be aware that a shared view’s owner might make changes to that view in the future, and that those changes will be reflected in the bookmark view that you create.

9. Click the **Select Folders/Layers** control (see above). The Select Folders/Layers panel appears.
10. Select the check box next to each layer that should be turned on when your new Bookmark View loads.

11. Highlight each layer or folder that should be included in the view, but not loaded.

12. Click the **Save** button at the bottom of the panel.

---

**Deleting an Existing Bookmark View**

*Note: If the bookmark is not shared out, only the owner can delete it. If the bookmark is shared, only the owner and other users with the privileges to share bookmarks can delete it.*

**To delete a Bookmark View:**

1. On the **Layers** tab, click the **Expand** button on the **Bookmark Views** control at the bottom of the tab.

2. After the Bookmark Views panel opens, right-click on the name of the Bookmark View that you want to delete. A pop-up menu appears.

3. On the menu, click **Delete View**. The Bookmark View that you selected is deleted.

**Using Playlists**

Bookmark Views can also be set up to display automatically in a specified sequence as a *playlist*. A playlist is very useful when you want ERMA to run on its own like a slide show. You can customize your playlist so that it plays all bookmarks or just specific bookmarks.
Creating a Playlist

To create a playlist:

1. On the Layers tab, click the Expand button on the Bookmark Views control at the bottom of the tab.

2. After the Bookmark Views panel opens, right-click on the name of the Bookmark View that you want to appear when your slideshow runs. A pop-up menu appears.

3. Click Add to Playlist. A number (in this case, 1) will appear to the right of the Bookmark View's name.

4. Repeat steps 2 and 3 for each bookmark you want to add to the playlist.
5. By default, Bookmark Views are displayed at 30-second intervals. If you want to make the interval longer or shorter, scroll to the bottom of the Bookmark Views panel and enter a new interval value.

6. To make the slideshow start playing, click the Play Slideshow button at the bottom of the panel.

Changing the Playlist Running Order

To change the running order of a playlist:

1. Click on the number next to a Bookmark View that's in the playlist. A field containing the existing number appears.

2. Enter a new number into the field. The order of the other Bookmark Views will update to reflect the change you just made.

3. Repeat step 1 and 2 until the playlist is in the order that you want.

Clearing a Slideshow

Since a slideshow can't be saved, an active slideshow is cleared automatically when you log out of ERMA. If you want to clear a playlist before then, follow the procedure below.

To clear a playlist:

1. Right-click in any empty spot in the Bookmark Views panel. A pop-up menu appears.
2. Click **Clear Playlist**
LEGEND TAB

The Legend explains the symbols used on the map to represent information. These colors and shapes help users to understand what they are seeing on the map.

Legend information is automatically generated or updated each time a layer is created or edited. Legend styles are populated from the styles that are set for a particular layer.
QUERY TOOLS TAB

ERMA has a tool that allows you to select one or more specific areas of the map by drawing a polygon around each area. Once you draw the polygon(s), you can analyze data using any of the query tools described in this section.

Creating and Deleting Polygons

Creating a Polygon

To create a shape on the map:

1. On the ERMA window, click the Query Tools tab.

2. Click Create Polygon. A message tells you that the Polygon Tool is active.
3. To make a polygon, click on a spot on the map and then move the mouse pointer to draw the polygon's first side. For each additional side, click again and draw the new side.

4. When the map displays the shape that you want, double-click or press any key to turn off the Polygon Tool.

5. Repeat steps 2 through 4 for each additional polygon.

Deleting Polygons

ERMA allows you to delete single polygons or all of the polygons on the map at once.
To delete a single polygon:

1. Click on the polygon that you want to delete. That polygon will turn (or remain) blue; all of the other polygons will turn orange.

2. Click Delete Selected. The selected polygon disappears from the map.

To delete all of the polygons on the map:

Click Delete All.

Using Polygons to View and Analyze Data

ERMA provides three tools for viewing and analyzing data using the polygon(s) that you have created.

- ERMA Layer Query by Polygon Tool. This is ERMA’s native polygon query tool.
- NOAA ESI Query Tool.
- U.S. Fish and Wildlife Service IPaC Tool.

ERMA Layer Query by Polygon Tool

IMPORTANT: The ERMA Layer Query by Polygon tool returns data for ERMA-hosted layers only (i.e. Internal services such as shapefiles). It does not return data for layers that are hosted externally (i.e. External WMS feeds such as NOAA Nautical Charts or AIS vessels).
The ERMA Layer Query by Polygon Tool allows you to create a subset of all active layers that are contained completely within the polygon(s) that drawn on the map, or which intersect the drawn polygons. All data for active layers is returned in a new browser window, and it can then be exported as:

- An Excel spreadsheet
- A KML (Google Earth) file
- A shapefile
- A SpatiaLite (SQLite) database

Metadata is available for each layer.

**To use the ERMA Layer Query by Polygon Tool:**

1. On the **Layers** tab, turn on all of the layers that you want to query.

2. On the **Query Tools** tab, create one or more polygons using the procedure in “Creating a Polygon” on page 35.

3. Click on the polygon(s) that you want to use in your query. To select multiple polygons, press the SHIFT key and click on each polygon you want to include.

4. Select one of these query types:
   - **Select all features that touch these polygons (intersect)** returns data for any feature in an active ERMA-hosted layer that is wholly or partially contained in the selected polygon(s).
   - **Select only features COMPLETELY inside these polygons (contains)** returns data for any feature in an active ERMA-hosted layer that is wholly contained in the selected polygon(s).

5. Click **Run ERMA Query By Shape**. ERMA will generate a subset of records based on your selections, and then display a window similar to the one below.
The **Results Summary** tab lists each layer for which data exists, and tells you whether there is data that could not be included because it is hosted externally. Separate tabs for each layer let you examine the data in more detail.

6. Decide whether you want to apply filters to the exported data.
   • If you want to filter the data, select **Apply filters to export** and then continue to step 7.
   • If you want to export all of the data, select **Export all data** and then skip to step 14.

7. Clear the check box next to each layer that you do not want to include in the exported file. Then:
   • If you want to export all of the data in the remaining layers, skip to step 12.
   • If you want to export only some of the data for at least one of the remaining layers, continue to the next step.

8. Click the tab for the layer that you want to filter.

9. Click **Enable Advanced Filters**.
10. Click **Select Filters** to open a drop-down list.

11. On the drop-down, select the check box for each filter that you want to use.

12. Repeat steps 8 to 11 for each additional layer you want to filter.

13. When you are done selecting filters, return to the **Results Summary** tab.

14. Click the button for your desired data export format. When ERMA has finished creating the export file, a dialog box will ask you where you want to save the file.

**NOAA Environmental Sensitivity Index (ESI) Tool**

This tool allows you to create NOAA Environmental Sensitivity Index (ESI) maps that provide a summary of coastal resources that are at risk if an oil spill, or other hazardous incident, occurs. The summary includes biological resources, sensitive shorelines, and human-use resources.

*NOTE*: You do not need to turn on any ESI layers before following the steps below. You will choose the layers you want during the procedure.

**To run an ESI query:**

1. On the **Query Tools** tab, create one or more polygons using the procedure in “Creating a Polygon” on page 35.

   Given the size of the ESI database and the time it takes to process large areas, it is a good idea to select a reasonably small area for your query (an island or section of shoreline, for example) rather than use a large region (such as an entire state).

2. Create one or more polygons using the procedure in “Creating a Polygon” on page 35.

3. Click on the polygon(s) that you want to use in your query. To select multiple polygons, press the **SHIFT** key and click on each polygon you want to include.

4. Click Run ESI Query.
5. When the ESI Table Tool appears, select the information that you want included in the ESI report.
6. Select the check box for each month that you want the ESI report’s data to cover. If you want data for a full year, click **Check All**.

7. If you want the report to include a section listing data that involves more than one of the information types that you have selected, select the **Report Area Intersection Summary** check box.

8. Click **Run ESI Tool**. A report is generated and then displayed in a new window similar to the one shown below.

   **NOTE**: If your ESI query does not produce results within a few minutes, you may need to quit the ESI tool and try again using a smaller polygon, fewer ESI layers, and/or fewer months.

---

### U.S. Fish and Wildlife Service Information, Planning, and Conservation (IPaC) Tool

The Information, Planning, and Conservation (IPaC) System provides information about U.S. Fish and Wildlife Service trust resources for your selected area, including threatened and endangered species. It also provides recommended conservation measures tailored to your project activities and trust resource species.

**To run an IPaC query:**

1. Create one or more polygons using the procedure in "Creating a Polygon" on page 35.

2. Click on the polygon(s) that you want to use in your query. To select multiple polygons, press the **SHIFT** key and click on each polygon you want to include.

   **NOTE**: IPaC does not currently support points or line segments. If you need to define your project location as a point or line segment, draw a small polygon around the location.
3. Click Run IPaC Query.

4. After a window like the one shown below opens, follow the prompts in the IPaC System to complete your query.

   **NOTE**: For help using the IPaC tool, go to [https://ecos.fws.gov/ipac/](https://ecos.fws.gov/ipac/).
The Draw tab allows you to draw points, lines, and polygons on the map, assign attributes, and share them with other ERMA users with the appropriate permissions. The drawings can also be made into ERMA layers in the Table of Contents and downloaded as GIS shapefiles depending on a user’s permissions.

**Draw Tab Overview**

**View list of Drawings:**

Depending on your account permissions you will see up to four options to view different Drawings:

- **Show All Drawings**: By all users in all regions
- **My Drawings**: Only the Drawings you’ve created
- **My Drawings + Shared Drawings**: The default setting of your Drawings and any shared ones
- **Shared Drawings**: Only shared Drawings

The other default setting is for a checked box to **Show Only Drawings in the [local] Region**. If you have permission to see other regions then you will be able to see those drawings when this box is unchecked.
To easily **search** the Drawings by Name or Region, type in the Search box and the Drawings table will be filtered by your search criteria.

You can also **sort** the Drawings by Shared status, Name, or Region. Click on the field name and the column will automatically sort. A small black arrow will appear above the column that is being sorted.
Creating a New Drawing

To create a new Drawing:

- Select the Draw tab, and click New Drawing. The Create New Drawing panel will appear.

**NOTE:** When users click the draw tab, by default the user will see My Drawings + Shared Drawings only in their region.

1. **Step 1: Name & Describe Your Drawing.** In the Name field (required) type a descriptive name for your drawing. For example:
In the **Description** field (required), type of brief description of the drawing. This description will populate the metadata lite once the drawing is saved and the layer is created.

2. **Step 2: Choose the type of drawing.** In the drop-down menu you can pick points, lines, or polygons.

   **NOTE:** Until you have added a feature you can change the geometry type. Once a feature is added, you will need to either click cancel at the top right or delete all added features to change geometry type.

3. **Step 3: Label, name attributes, and enter attributes.** Click on the **Show Fields Names** button to expand the option of naming three fields for attributes.

   **NOTE:** By selecting **Hide Field Names**, these options will return to hidden.

   ![Diagram of field names with a red arrow pointing to a species attribute](image)

   Click on the **Show Label Settings** button to expand the option of customizing the labels size, color, and placement for your drawing.

   ![Diagram of label settings](image)

   **NOTE:** By selecting **Hide Label Settings** these options will return to hidden.
4. **Step 4: Create (or modify) a drawing feature.** Select your **Drawing Color**, click the appropriate drawing tool, and add the features by clicking the map to or typing a lat/long.

   a. **Polygon options** – Choose a free-drawing polygon, a square, or a circle to create. When drawing the circle it will automatically show you the radius of the feature so you can make adjustments. To draw the polygon, click the vertices on the map and double click to close the polygon when finished.

   a. **Line options** – Click on the line icon then use your mouse to create the vertices on the map. Double click to complete the end of the line when finished.

   b. **Point options** – Click on the point icon then click on the map to create a new feature. The latitude/longitude fields will automatically be populated. Alternatively, you can enter a latitude/longitude in the fields then click the **Add Point** button to have it appear on the map. You can change the latitude/longitude and click the **Update Point** button as needed.

   - Each feature you create will be listed in a table at the end of Step 4. You can edit a feature by clicking on it in the table and making changes to its size, color, etc. in the preceding steps. You can delete a feature by clicking on it then selecting the trash can symbol next to it.

5. **Step 5: Label and set attribute values.** Once the shape has been created you have the option to create a **Label** and/or **Set Attribute Values** for each feature. If you have chosen to add attribute fields you can enter in values for the attributes in this section.

   **NOTE:** All shapes in each feature will share the same attributes. If you need different attribute values for other shapes then you will need to add another feature to enter those values.
NOTE: If you have multiple features you can choose to show all of them on the map as you work or you can show only the selected feature that you are working on.

6. Finally, click the **Save Drawing** button to add your Drawing to the table. ERMA stores the following metadata:
   - The Drawing name.
   - The contents of the **Description** field.
   - Your user name.
   - The date / time the Drawing was created.
   - The Drawing Layer ID number

7. Once you click Save Drawing, your drawing will be listed in **My Drawings** under View Existing Drawings. If you have the permissions to do so, here you can choose to **Share** your drawing with other users who have the permissions to see shared drawings. A green check box will appear next to the Drawing name indicating it has been shared.
Editing a Drawing

ERMA allows you to modify Drawings that you created. Users with Admin permissions can edit Drawings created by others.

To edit an existing Drawing:

1. Select the Draw tab, and open the drop down bar to locate one of the options:
   - Show all Drawings – All drawings from across all ERMA regions will be displayed in a searchable table below.
   - My Drawings – Only drawings you have created will be displayed in a searchable table below.
   - My Drawings + Shared Drawings – Both drawings I have created and drawings that other users have shared with me will be displayed in a searchable table below.
   - Shared Drawings – Only drawings that other users have shared with me will be displayed in a searchable table below.

2. Once you have found the drawing you would like to edit, select the row. ERMA will automatically zoom to the extent of the drawing.
3. Directly below the table you will find the edit button (see above), click it.
   
   **NOTE:** You can only edit drawings that you own or if you have Admin permissions.

4. The **Edit Drawing** panel will appear. You will have the options to change, subtract, or add features to the drawing.

5. Based on your level of privileges, do any or all of the following:
   
   - Enter a new name or description, or use the Color drop-down list to change the color of the drawing's figure.
   - Change the figure's location by clicking anywhere on the figure and dragging it to the new location.
   - Change the figure's shape by clicking on any of the figure's vertexes (or on the grab point located in the middle of each side) and dragging.
   - Add additional points, lines, or polygons by selecting the appropriate tool and entering in coordinates or simply clicking on the map.

   **NOTE:** If at any time you would like to cancel the edits that have been made to the drawing, click **Cancel** at the top right hand side of the panel.
6. Once you have made your edits to the geometry, click **Update Point/Polygon/Line**.

   **NOTE:** You cannot add new geometry of a different type. All drawings must consist of the same type of geometry.

7. If you would like to make edits to labels or set attribute values, do so in the last step, then click **Save Drawing**.

**To Copy an Existing Drawing:**

You can copy one of your own drawings or another user’s drawing and edit as needed.

1. In the Drawings table highlight the drawing you would like to copy.
2. Below the table click the **Copy** button.
3. The **Create New Drawing** dialog panel will appear. Give a name to your copy, and edit the description, color, shape, or attributes. Click the **Save** button when finished.

4. The copied Drawing appears in the table. By default it is not shared. Click the **Share** button to share with other users.

---

**Adding a Drawing to the TOC**

There are three ways to add Drawings to the Layers tab, or ERMA Table of Contents:

- Add a drawing to the My Drawings folder
- Add a drawing to the Shared Drawings folder
- Add a drawing to a folder within the TOC

Each of these requires different account permissions.

---

**To add a Drawing to the My Drawings folder:**

Drawings that are not shared will appear in the My Drawings folder.

1. When you’ve completed your drawing click the **Add to Layers Tab** button below the drawings table. This will make the drawing appear in your **My Drawings** folder at the bottom of the TOC. No other users will be able to see these drawings.
2. To remove this layer, click the garbage can icon next to the layer's name.

**To add a Drawing to the Shared Drawings folder:**

1. Drawings in the **Shared Drawings** folder must first be shared in the Draw tab. In the drawings table select the drawing you want to share and click the **Share** button. A green checkmark will appear next to the drawing’s name.

![Screenshot of Share button with checkmark]

Next, click the **Add to Layers Tab** button. ERMA will take you to the **Layers** tab. At the bottom of the TOC will be a folder called **Shared Drawings** with your new layer. Currently the layer is set to Public and anyone with access to ERMA can see the shared drawing.

![Screenshot of layers tab with shared drawings]

2. By clicking on the **Manage** checkbox and the **Edit** button in the TOC to open the **Layer Record** window, this layer is now able to be edited like any other ERMA layer, such as changing its **Layer Name** and **Privileges**.
3. To remove the layer click on the **Manage** checkbox, then click on the layer’s name and the **Edit** button. Scroll to the bottom of the **Layer Record** and click the **Delete** button.

---

**To Move a Drawing into a TOC Folder**

Only Shared Drawings can be moved into the ERMA TOC folders.

1. Click the **Manage** checkbox then select the Shared Drawing you wish to add from the **Shared Drawings** folder then click the **Edit** button.

2. In the **Layer Record** window create a new **Layer Name** or keep the one from the drawing name.
3. In the ERMA TOC click on the folder where you want the layer to reside.

4. In the Layer Record window click the **Use TOC Selected Folder** button to identify the new folder where the layer will reside.

5. Edit the necessary **Visibility**, **Sensitivity**, and **Applicability**.

6. Browse to a **Metadata** document or enter text into the **Additional Information** field.

7. Click the **Save** button and the layer will appear in the folder.

**NOTE**: This drawing layer is still connected to the original drawing in the Draw tab. Any edits made to the original drawing will be reflected in this layer.

8. If you want to delete the drawing from the Draw tab, it will also delete the layer in the TOC folder.

9. To delete the layer from the folder, select the layer then click the Edit button. Click the Delete button at the bottom of the Layer Record window.

**Download the Layer as a Shapefile**

Once your drawings have been added to the Layers tab, either as My Drawings, Shared Drawings, or in a TOC folder, you can download the layer as a GIS shapefile.
1. Click the checkbox next to the name of the layer or layers you want to download.

2. Go to the **Download** tab and click the **Download Shape Files** button.

3. You will be prompted to save an **ERMA.zip** file to your desktop. Select the destination and click **Save**.

4. Unzip the file on your desktop. You will find a folder named with the LayerID number. Inside is another zip file with the shapefile named "drawing". The attributes of your drawing will be in the shapefile DBF.
The **Zoom** tab allows you to zoom to a particular location in any of these ways:

- By latitude and longitude
- By the place name for a geographic location.
- By NAIS ship location using a ship’s MMSI number or its name.

**Zooming By Latitude and Longitude (Lat/Lon)**

**To zoom using latitude and longitude:**

1. In the **Zoom to Lat/Lon** field, enter a known latitude and longitude in any of these formats:
   - Decimal degrees. For example:
     18.384, -65.655
   - Degrees decimal minutes. For example:
     66 45.8000W
   - Degrees minutes seconds. For example:
     -66 45 48
2. Select a zoom level from 1 (zoomed out to show the whole map) to 19 (zoomed in as close as possible).
3. Click **Go**. A black X appears on the map at the exact location you selected.
Zooming By Place Name (Place)

To zoom using a place name:

1. In the **Zoom to Place** field, enter the name of a geographic location or an address.
   **Hint**: Enter an address in the same format that you would use with Google Maps or other popular online map application. For example:
   
   **7600 Sand Point Way NE, Seattle, WA.**
   
   Unless a street name is very common, you may be able to zoom to the correct address using only the street address.

2. Select a zoom level from 1 (zoomed out to show the whole map) to 19 (zoomed in as close as possible).

3. Click **Find It!** A black X appears on the map at the location you selected.

---

### Zooming By Ship Number (Ship MMSI) or Ship Name

Users with the required privileges have access to the NAIS (Nationwide Automatic Information System) feed. This is a near real-time data feed that shows the name, location, status, and other details for most open-water vessels. If you know a particular ship’s Maritime Mobile Service Identity (MMSI) number or the ship's name—or at least part of the number or name—you can use this tool to find its last received location.
To zoom by ship number:

**NOTE:** It is helpful, although not necessary, to turn on the NAIS layer before or after zooming to a specific ship. It enables you to see the vessel locations and to use the Identify Tool to get additional information about the ship you’ve zoomed to.

1. In the **Zoom to Ship MMSI** field, enter at least four digits of the known ship’s 9-digit MMSI number.
   
   If more than one ship matches the number or digits that you entered, a drop-down list appears. Select the ship that you want from the list.

2. Select a zoom level from 1 (zoomed out to show the whole map) to 19 (zoomed in as close as possible).

3. Click **Find It!** A black X appears on the map showing the most recent received location of the ship.
To zoom by ship name:

1. In the **Zoom to Ship MMSI** field, enter at least four characters of the known ship’s name. If more than one ship matches the name or characters that you entered, a drop-down list appears. Select the ship that you want from the list.

2. Select a zoom level from 1 (zoomed out to show the whole map) to 19 (zoomed in as close as possible).

3. Click **Find It!** A black X appears on the map showing the most recent received location of the ship.

**NOTE:** The **Zoom to** field will display the ship’s MMSI, not its name. Additionally, it is helpful, although not necessary, to turn on the NAIS layer before or after zooming to a specific ship. It enables you to use the Identify Tool to get additional information about the ship you’ve zoomed to.
ERMA users can download any available shapefile data to their computer for use in ArcMap or other GIS application.

**To download shapefile data:**

1. On the **Layers** tab, turn on the layers that you want to download.
2. Select the **Download** tab. You’ll see a list of the layers that are available for downloading. You’ll also see the layers that cannot currently be downloaded, if there are any.
3. Click **Download Shapefiles**. You browser will then prompt you to save a ZIP file that contains the full shapefile data.
   - No legend information is downloaded unless a LRY legend file was originally uploaded with the shapefile. In this case, the LRY file will be included.
   - Multiple shapefiles are saved into a single file called erma.zip rather than as separate ZIP files.
PRINT TAB

This tab allows you to print a PDF version of the map displayed in the ERMA window. This map is suitable for saving to your desktop or emailing to others.

To print a map displayed in the ERMA window:

1. On the ERMA window, select the Print tab. Your map is displayed with rectangular watermarks indicating the approximate locations of the Print Logo and Legend.

2. Depending on the size of your monitor, the ERMA TOC may be blocking part of your map. If needed, click the Hide TOC button (located in the lower-right corner of the panel) to hide the Print panel and get a full view of what the printed map will look like. You can move the map around until what appear on the screen matches what you want to print. Click the Show TOC button when you are done.
3. Under Paper Size, select the size of the paper you will print the map on, and the orientation of the map image on the paper.

4. In your web browser, open the print settings and make sure that the paper size and orientation match what you have selected on ERMA’s Print tab.

5. Click Print PDF Map. ERMA creates a printable PDF file and sends it to your computer. If you open the PDF file, you’ll see that the map includes your name and a date/time stamp in the lower-left corner.